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1. Cautions on Assembly

e There will be some steps where force is necessary.
Please take the proper measures and precautions to not hurt yourself or damage the parts
and follow the instructions as described.

* You will need a phillips screwdriver (+ head) for assembly.
¢ Please use the provided pictures as a reference during assembly.

* Please be aware that the colours and/or appearance of some parts in the provided pictures
and those provided may be slightly different.

¢ The required program for the M5Stack has already been included.
How to install page is [7. Firmware Installation]
PLENSStack https://github.com/plenprojectcompany/PLEN5Stack

¢ When assembling the servo motors, the initial rotational position of the gear on the motors is
important.
The assembly instructions includes initial positioning for the motors.
Please ensure all motors are properly set.

¢ When setting the servo motors, make sure you wait at least 2 seconds after turning the
power switch on until the servo motors automatically set to their initial position.
If the servo motors do not move after 2 full secods, please if check they are connected

properly.
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2. Contents list

2.1 Common Parts
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. M5Stack

. Battery

. Control Board

. Switch Board PCB
. Servo Motors x 8
. Head Board Cable
. Power Cable

. USB Cable

. Head Parts(top, bottom)
. Chest Parts

. Servo Bracket

. Servo Fixer

. Back Parts

. Switch Board Holder
. Shoulder Parts

. Arm Partsx2

. Thighs Parts x 2
. Legs Parts x 2

. Black Screw x 4

. Silver Screw x 7
. Servo Horn x 6

. Label Sticker
. head board
. Connector tool
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3. About the Servo motor

3.1 Connector orientation

1. There is a direction in the connector of the servo motor. Make sure that the white cable is on
the inside.

Connector orientation
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3.2 About the angle of Servo horn

1. Body balance is important for biped robots. but, since servomotors have individual
differences in rotation angle, it is necessary to absorb the individual differences by the servo
horn attached to this.

Therefore, the angle of the servo horn needs to be precisely adjusted. If this adjustment is
not successful, you will not be able to walk or fall easily.
Here we will explain how to make this adjustment.

2. The servo horn has a slight offset between the inner serration and the front cross.
Therefore, when rotating the cross of the servo horn by 90 degrees, there is a point where
the cross is just horizontal.

Find this and fix the servo horn.

3. As a method other than servo horn adjustment, a method to adjust by program is also
prepared. (Coming soon)
The shoulder parts are integrated with the servo horn and can not be rotated by 90 degrees,
so they need to be adjusted in the program.

servo horn fix image
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4. Assembly

4.1 Preparation

Necessary items

1. Servo Motors x8
2. Label stickers or Circular Stickers
3. Pen

Necessary items

Procedure

Fix the servo number stickers to each Servo motor cable.Write the humbers 0-7 on eight stickers
and place them Attach the sticker in a half-folded form to the servo motor cable.

Sticker placement
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4.2 Switch board assembly
Necessary items

1. switch board set (switch board PCB, switch board holder, screw x2)

Necessary items
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Procedure

1. Align the circuit board and plastic part

2. Screw in the circuit board using the two screws at the corners
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4.3 Circuit board and battery wiring
Necessary items

. back part

. switch board
. battery

. control board
. M5Stack

. power cable

o U~ WN -

Necessary items
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Procedure

1. Connect the power cable to the switch board

2. Insert the switch board into the back plastic part with the switch and connector going
through the appropriate holes as shown in the picture.
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3. Connect the battery to the switch board following the below reference picture.

4. Connect the control board and switch using the power cable. The connectors are different so
please ensure the correct connector slides smoothly into the pins.
X It is necessary to remove the power cable at the time of "Control board wiring" mentioned
later. In this case, since it is hard to remove the cable from the connector, for children and
people with weak force, use the supplied connector tool. This is a tool to make
it easy to remove by holding this tool between the power cable and the connector.
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connector tool use example

5. Plug in the M5Stack to the control board.
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6. complete set of board assembly is seen below
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4.4 Servo motor set-up
Necessary items

1. Servo motors x4 (numbers 0,1,4, and 5)
2. Servo bracket

Necessary items
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Procedure

1. Orient the servo bracket such that the long back is horizontal and towards the back when
inserting the servo motors.
The side of the bracket with this long bar in the middle is the "back" of the part and
concordantly the back of the robot.
Insert servo motor #0 into the servo bracket as shown. This will be the robot's left arm.
Be careful not to have the cable of servo motor #0 pinched between the motor casing and
plastic parts when assembling.
Have the servo motor cable come out the "front" side of the bracket.

2. Insert servo motor #4 following the same procedure as #0 on the opposite side of the
bracket.
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3. Again, be careful not to have the cable of servo motor #1 pinched between the motor casing
and plastic parts when assembling.

4. Insert servo motor #5 following the same procedure as #1 in the last available position in
the bracket.
Ensure all servo motor cables are coming out the "front" face of the bracket.
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4.5 Assembling the Thighs

Necessary items

1. The previously assembled servo bracket with servo motors.
2. The previously assembled control board¥
o battery
o switch board
3. Thigh plastic parts x2
4. Servo horn x2
5. Screws x2

Necessary items
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Procedure

1. Ensure the switch board switch is in the off position.
Connect servo motors #1 and #5 to the control board pins as shown.
The servo motor pins numbering is given in the Appendix 5.2 picture.
When connect the motors into the pins, ensure that the black (ground) cable is towards the
outside of the control board.
Turn the switch on the switch board on.
*if you have not installed firmware, see [7. Firmware Installation].

2. The servo motors should rotate automatically to their initial position.
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3. Attach the servo horn plastic parts to servo motors #1 and #5 as shown in the photo.
Ensure the axis of the + on the horn is aligned with the edges of the servo motors.

4., Orient the servo bracket such that the bar across the center of the bracket is horizontal and
at the back of the assembly.

The orientation in the photo below shows the bracket such that the robot's front is being
looked at and the head is on top.

Attach the plastic thigh parts onto the servo horns as shown, such that the bump on the
plastic parts are pointing in the same direction as the "front" of the servo bracket.
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5. Fix the thigh parts to the horn with the screws.

6. After fully screwing in each of the thigh screws,
remove the servo cables from the control board.
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4.6 Attaching leg parts

Necessary items

uaua N W N =

. body sets

. circuit sets

. servo x2 (3,7)
. legs x2

. servo horn x2

Necessary items
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Procedure

1. Insert servo motors humbers 3 and 7 into the thigh parts as shown.
The gears of the servo motors will be pointing towards the "back" of the robot.

2. Connect the servo cables for motors 3 and 7 into the control board.
Servo motor number 3 is to be placed as the robot's left leg.
Motor number 3 is connected to the corresponding pin set #3 again with the black (ground)
cable towards the outside of the control board.
Repeat for motor #7. Turn the switch board back on.
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3. The servo motors should rotate automatically to their initial position.

4. Similar to servo motors #1 and #5, attach the servo horns to each servo motor such that
the axis of the + on the horn is alighed with the edges of the servo motors as closely as
possible.
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5. Attach the feet plastic parts while paying attention to ensure the wider side of the feet are
towards the outside of the robot.

Insert the + side of the foot into the servo horn and then insert the opposite side of the foot
into the bump on the front side of the thigh.
*This may take some strength.

6. After fixing the feet to the servo motors,
unplug the servo motors from the control board and turn the power switch off.
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4.7 Shoulder parts assembly
Necessary items

1. body sets

2. circuit sets
3. shoulder x2
4, screw x2

Necessary items
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Procedure

1. Connect servo motors #0 and 4 from the servo bracket into their respective pins on the
control board and turn the power switch on.

2. The servo motors should rotate automatically to their initial position.
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3. Insert the shoulder parts into servo motors 0 and 4 such that the flat edges are aligned with

the servo motor as closely as possible.
The wider side of the shoulder parts with the + cut should be towards the back of the robot.

Screw in the plastic shoulder part into the servo motor.

4. Repeat the previous step for the opposite shoulder
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5. Unplug the servo motors from the control board and turn the power switch off.
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4.8 Arm parts assembly

Necessary items

uaua N W N =

. body sets

. circuit sets
.arm x2

. servo x2 (2,6)
. servo horn x2

Necessary items
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Procedure

1. Place the servo motors #2 and 6 into the plastic arm parts such that motor #2 is the robot's
left arm.

2. Directly connect servo motors #2 and 6 into their respective pins on the control board and
turn the power switch on.
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3. The servo motors should rotate automatically to their initial position.

4. Attach the servo horns to each servo motor such that the axis of the + on the horn is aligned
with the edges of the servo motors as closely as possible.
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5. Insert the left and right arms into the shoulder pieces lining up the servo horn with the cut +
shape on each shoulder.
*Ensure the
arms are inserted pointing down.

6. After fixing the arms to the shoulder parts,
unplug the servo motors from the control board and turn the power switch off.
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4.9 Servo fixer attachment
Necessary items

1. Body assembly set
2. Servo fixer part

Necessary items
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Procedure

1. Pass the cables of the eight servo motors through the servo bracket and through front as
shown.

2. The cables of motors #3 and 7 are passed through the lower hole of the bracket, and left
there for later.

3. Servo motors #1 and 5 are passed between the opening in the servo fixer,
while the remaining cables are temporarily wrapped up around the top ofthe body to keep
them out of the way.

4, Attach the servo fixer part so as to not catch and pinch any of the other servo motor cables.
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4.10 Control board wiring
Necessary items

1. Battery assembly
2. Control board assembly

Necessary items
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Procedure

1. Remove the M5Stack and the power cable from the control board.
Pass the power cable along with the servo motor cables from the back side through the front
hole in the body and reconnect the power cable to the control board again.

2. Put the battery into the back plastic part on top of the switch board and keep the battery
cable underneath the battery.
Attach the back plastic part to the back of the servo bracket.
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3. Connect all servo motor cables following the appropriate order with servo motor number
matching pin number.
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4.11 Head part assembly
Necessary items

1. body sets

2. head parts(top, bottom)
3. head board

4. head board cable

Necessary items
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Procedure

1. Take apart the top and bottom plastic parts of the head

2. Connect the final head-board control cable to the head-board
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3. Unscrew the nuts on each LED down about 3mm.

4. Pass the head-board cable through the hole in the bottom side of the head plastic part.
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5. Bend the LED legs 90 degrees such that the head-board is rotated up,
and insert both LEDs into the semi-circular grooves in the bottom plastic heat part such that
the nuts on each LED are on the inside of the head.

6. Align and place the top plastic head part onto the bottom part by first passing the LED bulbs
through the top heat eye holes.
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7. Insert the head-board cable through the top hole in the servo bracket and pass through the
front side of the body.
Insert the assembled head into the same hole to fix the head to the servo
bracket.

8. Connect the head-board cable into the control board.
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4.12 Chest assembly
Necessary items

1. body sets
2. chest

3. M5Stack
4, screw X 2

Necessary items
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Procedure

1. Remove M5Stack from control board.
Pass the control board through the body part and bring it out to the front.

2. Attach the chest parts to the servo bracket body.
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3. Screw the control board to the chest part

4, Insert the M5Stack.
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5. Switch the robot on and confirm if all servo motors have rotated and initialized.

6. Press the M5Stack A and B buttons to check that the limbs work. C button is blink the EYE
LED.
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5. Motion check

5.1 Let's walk the PLEN5Stack!

1. Press A Button to check if PLEN5Stack walks.

2. Enjoy PLEN5Stack!
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6. How to charge battery

1. Connect PLEN5Stack ( back Switch Board ) and PC ( or USB charger ) with
cable.

2. Charging : LED ON

3. Full charge : LED OFF
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7. Firmware Installation

How to Install

1. Download (and install) Arduino IDE from arduino.cc website. (Choose your environment,
then click "JUST DOWNLOAD" button.)

. Add board manager URL: https://dl.espressif.com/dl/package_esp32_index.json

. Add esp32 board

. Add M5Stack library

. Download this repository from here.

. Open the firmware.ino using the Arduino IDE.

. Click the upload button (that is like a right arrow).

N O o1~ WN
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https://www.arduino.cc/en/Main/Software
https://github.com/plenprojectcompany/PLEN5Stack/archive/master.zip
https://github.com/plenprojectcompany/PLEN5Stack/blob/master/firmware/firmware.ino

Preliminary Arrangements

To write PLEN5Stack's firmware requires Arduino IDE ver.1.8.0 or above. Please download and
install it before to do continued steps.

How to Download the Arduino IDE

Access the Arduino IDE download page, and then choose your environment.

Download the Arduino Software
Choose from here!

Windows Installer
Windows zIP file for non admin install

ARDUINO 1.6.12 Windows app: Get B

The open-source Arduino Software (IDE) makes it easy to
write code and upload it to the board. It runs on
Windows, Mac 05 X, and Linux. The environment is
written in Java and based on Processing and other open- .
source software Llnux 32 bits
This software can be used with any Arduino board. Linux 64 bits

Refer to the Cetting Started page for Installation Linux ARM (experimental)
instructions.

Mac OS X107 Lion or newer

©.0,

Release Notes
Source Code
Checksums (sha512)

Click “JUST DOWNLOAD"” button. (You do not need to select donation menu.)

Support the Arduino Software

Consider supporting the Arduino Software by contributing to its development. (US tax payers, please note this contribution
is not tax deductible). Learn more on how your contribution will be used

SINCE MARCH 2015, THE ARDUINO IDE HAS BEEN DOWNLOADED

TIMES. (IMPRESSIVE!) NO LONGER JUST FOR ARDUINO AND
GENUINO BOARDS, HUNDREDS OF COMPANIES AROUND THE WORLD ARE
USING THE IDE TO PROGRAM THEIR DEVICES, INCLUDING COMPATIBLES,
CLONES, AND EVEN COUNTERFEITS. HELP ACCELERATE ITS DEVELOPMENT
WITH A SMALL CONTRIBUTION! REMEMBER: OPEN SOURCE IS LOVE!

$3 $5 $10 $25 $50 OTHER

Click h PSS  conTRiBuTE 2 DownLOAD
Ic @re. i JusTPowNLoAD H
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Setting the Arduino IDE

1. [File] -> [Preferences]
2. Right button for Additonal Boards Manager URLs
3. Inpust the URL: https://dl.espressif.com/dl/package_esp32_index.json
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Install board

1. [Tools] -> [Boards:...] -> [Boards Managers...]
2. Input the [esp32] for Boards Managers
3. Instal the esp32
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Install libraly

1. [Skecth] -> [Include Library] -> [Manage Libraries...]
2. Input the [mb5stack] for Library Manaber
3. Install the [M5Stack]
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board select

1. [Tools] -> [Board:...] -> [M5Stack-Core-ESP32]
2. [Tools] -> [Port] -> Select the your Serial Ports (Port name is different in each
environments.)
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Installation Procedure

Download [PLEN5Stack] repository
1. Open “firmware.ino” (This is placed “firmware/” directory) with Arduino IDE.
2. Connect M5Stack to PC with USBTypeC cable.

3. Click the Upload[->] button.
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Appendix

PLEN5Stack servo numbering

Control board terminal labelling

PLEN5Stack Support

If you have any questions, please contact one of the following

e PLEN5Stack Slack community : http://uOu0.net/YJzp
e PLEN Support : https://plen.jp/wp/contact/
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